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Chapter 1: Getting Started

1.1  Evaluation Kit Overview

The Broadcom® AFBR-S50 evaluation kit is composed of the following main components:

 NXP FRDM-KL46Z evaluation board: Embedded microcontroller platform (ARM Cortex-M0+) used to read out the 
AFBR-S50 ToF sensor's data and exchange with the PC.

 AFBR-S50 adapter board: The circuit board on which the AFBR-S50 ToF sensor is mounted. It delivers out-of-box 
connection between the sensor and a microcontroller board without the need for soldering (just plug and play).

 USB-mini cable: Required to establish a communication between the AFBR-S50 and your system environment (for 
example, PC, embedded application system).

Download the software development kit (SDK) from the Broadcom website:
https://www.broadcom.com/products/optical-sensors/time-of-flight-3d-sensors/

Figure 1:  Evaluation Kit Components

1.2  Hardware and Software Setup

Step 1: Install the main application and all necessary drivers by using the AFBR-S50 SDK setup wizard. The initial setup 
wizard window displays as follows.

Figure 2:  Initial Setup Wizard Window

AFBR-S50
Explorer Application

USB
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Step 2: Install the main driver and all additional modules to enable the full performance of the device:

Figure 3:  Installing the Device

Step 3: Plug in the USB cable.

CAUTION! The correct USB port for this step is labeled as KL46Z on the bottom side of the NXP board.

Figure 4:  Connecting the USB Cable
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1.3  Updating the Device Software

When updating the AFBR-S50 SDK, the software on the evaluation kit must also be updated manually to match with the 
installed GUI. This is done from the AFBR-S50 Explorer App by performing the following steps:

Step 1: Install the desired device software, as described in Hardware and Software Setup, and open the AFBR-S50 Explorer 
App. 

Step 2: Connect the red AFBR-S50 evaluation board via the OpenSDA interface to the PC. An additional driver is not 
required. 

Figure 5:  Connecting the Red Evaluation Board with OpenSDA Labeled on the Bottom Side

Step 3: In the explorer App, go to menu Help > Flash Device Software > Flash…_USB.srec, and wait until the device is 
successfully flashed.

Figure 6:  Flash Device Software Option

Step 4: When flashed successfully, connect the device using the USB port labeled with KL46Z, and run it as described in 
the following section.
Broadcom AFBR-S50-EK-UG102
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Figure 7:  Connecting the Device Using the USB Port Labeled KL46Z
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1.4  Performing a Distance Measurement

Step 1: Start the Explorer Application, AFBR.S50.Explorer.exe, for example, by clicking Windows Menu > AFBR-S50 SDK 
> AFBR S50 Explorer.

Step 2: Open a USB connection by clicking the green plug symbol.

Figure 8:  Green Plug Symbol

Step 3: Start the measurement by clicking Start.

Figure 9:  Starting the Measurement

ATTENTION: To troubleshoot problems with starting the measurement, see Troubleshooting and FAQs.

Step 4: Optionally, set up the device to your needs by choosing, for example, a measurement mode and frame rate both 
before and while measuring. The changes will immediately become effective after pressing the respective Set buttons on 
the right side of each applicable parameter.

Figure 10:  Measurement Mode after a USB Connection Has Been Opened

NOTE: Information from the Configuration API section is loaded when a device is successfully connected to the explorer 
app. The PBA default values differ among the sensor types.
Broadcom AFBR-S50-EK-UG102
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Chapter 2: AFBR-S50 Explorer

This section is intended to make the user familiar with the graphical user interface (GUI) of the AFBR-S50 Explorer 
application and support the evaluation of a given ToF sensor device.

The AFBR-S50 Explorer software connects to the AFBR-S50 evaluation board using the USB interface. It receives the 
measurement data from the device software running on the NXP board's microcontroller and displays it in a convenient way. 
Furthermore, the ToF sensor device can be configured and calibrated by using the AFBR-S50 Explorer GUI.

2.1  AFBR-S50 Explorer Overview

Open the AFBR-S50 Explorer. The following screen is displayed.

Figure 11:  AFBR-S50 Explorer Display Screen

The AFBR-S50 Explorer main window consists of the following five basic elements:

1. Menu bar

2. Controller tool bar

3. Data visualization windows

4. Tool windows

5. Status bar
Broadcom AFBR-S50-EK-UG102
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2.2  Exploring the Menu Bar

The AFBR-S50 Explorer menu bar includes the following three elements:

 Device

 View

 Help

Figure 12:  Device Menu

From the Device menu, options are available to open and close the USB connection, trigger measurements, create a log 
data file over a data logger to store measurement data, monitor and store the communication of the serial interface, and, 
once connected, reset the microcontroller on demand.

All data measured by the ToF sensor device can be logged to a file for plotting and evaluating the measurement results. The 
log file is saved to the entered path.

Figure 13:  Data Logging Options

The data logger starts recording once a destination path and file are chosen. In addition, another small menu bar for the data 
logger is available.

After clicking Stop, a message appears in the explorer application with the information and the saved number of samples. 
Broadcom AFBR-S50-EK-UG102
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Figure 14:  Data Logger Recording Options

NOTE: The amount of data of the data logger output file can be changed by choosing a different data output mode from 
the Configuration API in the API section if Advanced Mode is enabled in tab options, section API Options (see also 
Section 2.4.3, Options Tab).

For formatting reasons, open the created log file either with an advanced text application (for example, Notepad++) or import 
it directly into a data analysis program. Another helpful debug feature is to perform a Serial Trace of all the bus transfers 
between the microcontroller and the connected device. After the start of a Serial Trace, the application asks for a path to 
save the Serial Trace Data. Both the Measurement Log Data and the Serial Trace are saved as .txt files.

Figure 15:  View Menu

Single view modules can be enabled or disabled in the Explorer app with the View menu.

The Help menu is used to flash the current AFBR-S50 device software to the connected microcontroller, open the latest 
status message log, reset the application values to default, and provide additional links to all necessary documentation on 
the SDK.
Broadcom AFBR-S50-EK-UG102
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Figure 16:  Help Menu

The AFBR-S50 Controller Tool Bar gives quick access to the most important operation elements regarding measurement 
and Reset of the microcontroller. On the left it delivers a simple connect and disconnect menu to open up a connection via 
USB port to the microcontroller on the evaluation kit board.

 Single: Sends a trigger signal to the device to perform a single measurement frame. Afterwards the device goes to idle 
state.

 Start: Starts a periodic measurement loop.

 Stop: Stops the periodic measurement loop and makes the device go to idle state. Note that this only stops the 
measurement loop and prevents new measurements to be triggered. However, it does not stop a currently ongoing 
measurement frame.

Figure 17:  AFBR-S50 Controller Tool Bar
Broadcom AFBR-S50-EK-UG102
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2.3  Data Visualization Views

Below the AFBR-S50 Controller Tool Bar, all measurement data gathered by the ToF sensor device can be displayed in three 
different views: 1D Plot, 3D Plot, and Raw Data. Each of the three views are introduced in the next sections.

Unlike the different views, the Measurement Status is always shown and gives information on the timestamp of the measured 
signal, the corresponding frame rate, the Dynamic Configuration Adaption (DCA, the number of Digital averaging Samples), 
optical power, and the pixel gain.

NOTE: The displayed Frame Rate may differ depending on the characteristics of your serial connection (for example, USB 
cable length, and so on).

Figure 18:  Measurement Status Example

2.3.1  1D Plot View

The 1D Plot View consists of three plots and shows the measurement data in real time. It is the standard measurement view 
displayed after the first start of a measurement. The x-axis for every chart inside the 1D plot View reflects the number of 
measurement samples.

 Range Plot

 Amplitude Plot

 Pixel Count Plot

Figure 19:  1D Plot View GUI
Broadcom AFBR-S50-EK-UG102
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The Range plot element of the 1D Plot View is able to display up to four different range plots:

 Binned Range: Plots the average range over all pixels that are determined by the pixel binning algorithm. This value 
represents the current range in meters. 

 Smoothed Binned Range: Plots a time based moving average of the Binned Range. To adjust the algorithm of the time-
based moving average, go to the 1D Plot Options View inside the Options tab. A greater SMA data buffer size may 
result in a slower moving visualization.

Figure 20:  Generic Data View Options

Choose between two different algorithms used for calculation of the averaged measurement results:

– Simple Moving Average: The mean calculated of the previous N data without any weighting. The SMA Data Buffer 
Size defines the magnitude used for SMA calculations.

– Exponentially Weighted Moving Average: A type of an infinite impulse response filter that applies exponentially 
decreasing weighting factors. The weighting for each older datum decreases exponentially but never reaches zero. 
EMA Weight implies the quantifier used for the calculation of the EMA. Lower values result in less weighting of past 
measurement outcome and thus longer averaging times.

 Sigma of Binned Range: The blue cloud determines the current time based on moving the standard deviation of the 
sensor signal; inside the 1D Plot Options, choose between a deviation width of 1 Sigma and 3 Sigma.
Broadcom AFBR-S50-EK-UG102
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Figure 21:  1D Plot Options

The different plots of the Range plot element can be turned either on or off by selecting the respective check boxes inside 
the Options Panel. It is also possible to change the minimum and maximum displayed range of the respective axis or select 
the Auto Scaling option.
Broadcom AFBR-S50-EK-UG102
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Figure 22:  1D Plot Options

Figure 23:  1D Plot Example

 Integration Energy: Calculated by the integration depth per sample times the optical output power.

 Amplitude (Maximum) Plot: Shows the current maximum measurement signal amplitude, which is determined by all 
pixels that are selected by the Pixel Binning Algorithm. 
Broadcom AFBR-S50-EK-UG102
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Figure 24:  Active Pixel Count vs. Saturated Pixel Count

 Active Pixel Count: The value of Active Pixel Count reveals the number of pixels that are used for calculating range and 
amplitude with respect to the current Pixel Binning Algorithm.

 Saturated Pixel Count: The value of Saturated Pixel Count reveals the number of pixels being in saturation state due to 
too much optical power received.
Broadcom AFBR-S50-EK-UG102
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2.3.2  3D Plot View

The second tab of the Data Visualization Window opens the 3D Plot View revealing more pixel-specific information on the 
measured range and amplitude in real time:

Figure 25:  3D Plot View

This 3D Plot View shows the retrieved measurement signal of every single pixel of the sensor's pixel matrix.

 3D Range: The left plot shows the time based average range values for each available pixel.

 3D Amplitude: The right plot inside the 3D plot view shows the time based average amplitude values for each available 
pixel. 

There is also a Color axis for each of the two 3D plots that highlights the corresponding signal magnitude.

Hide binned pixels to see only pixels considered valid for the measurement by enabling the Hide Binned Pixels in Plots 
option in the 3D Plot options tab.
Broadcom AFBR-S50-EK-UG102
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Figure 26:  Hide Binned Pixels Option

Invalid pixels that do not satisfy the binning criteria will disappear from the plot.

Figure 27:  Hidden Binned Pixels

For a closer look at each pixel, zoom and rotate the 3D plots using the mouse.

 To move a plot, click and hold the scroll wheel.

 Rotate the plots by clicking and holding the right mouse button.

 Use the scroll wheel to zoom in and out.

 Double-click the scroll wheel to reset a plot to its default point of view.
Broadcom AFBR-S50-EK-UG102
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2.3.3  Raw Data View

The raw data view is not visible by default, it has to be enabled in the help menu first.

Figure 28:  Enabling the Raw Data View

Raw Data view gives additional details about each pixel's measured range and amplitude results including the corresponding 
mean values and signal deviations (referred to as sigma). Furthermore, Mean and Sigma of both Raw Range and Raw 
Amplitude can be displayed as either SMA or EMA weighted (Mean(s), Mean(e), Sigma(s), Sigma(e)). The above 
screenshot shows not all Pixels for reason of better overview. Keep in mind that the choice of SMA and EMA affect the 
displayed values of Sigma and Mean in different ways.

Figure 29:  Raw Data View

By enabling the Pixel Status Values check box, the Raw data view displays several status flags for each pixel.
Broadcom AFBR-S50-EK-UG102
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Figure 30:  Single Pixel Status

For a detailed description of the single statuses, open the API reference manual and type argus_px_status_t in the 
search field.

Choose which of the results to keep visible or hidden by selecting the associated Pixel View Options from the Options Panel. 
In addition, the Numeric Format of the displayed results can be adapted.

Figure 31:  Pixel View Options
Broadcom AFBR-S50-EK-UG102
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2.4  Tool Panel Overview

This section introduces the tool panel which is located on the right side of the explorer GUI.

Figure 32:  Location of the Tool Panel in the GUI

2.4.1  API Tab

In general, this tab is organized in the three categories: Generic API, Configuration API, and Calibration API. All functions 
and accessible parameters shown in this section give an overview about the interoperability with an AFBR-S50 sensor. As 
indicated in Figure 33, applicable settings have a Get, Set, or both button on the right side to either retrieve the current 
parameter setting from the sensor (Get) or send a new target setting to the sensor (Set).

Figure 33:  Configuration API with Get/Set Buttons

Generic API

When the connection to the evaluation board is established, the Generic API section is filled with important information on 
the device, such as the API and explorer version number, module type, chipID, and so on.

 

Broadcom AFBR-S50-EK-UG102
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Configuration API

This is the category where users can modify basic settings of the sensor, such as the measurement mode, frame rate, dual 
frequency mode, shot noise monitor mode as well as optimizing the pixel binning algorithm settings. However, because all 
predefined settings are based on empirical data for best sensor operation, there is no need to change unless there is a 
known reason.

Figure 34:  Configuration API

Calibration API

In general, each AFBR-S50 ToF sensor is factory calibrated and immediately ready to take measurements. When it comes 
to a system integration, it may be necessary to optimize the performance for a specific application, which can be carried out 
by the calibrations offered in this section of the API tab. It consists of two main subsections, which are the Range Offset 
Calibration and the Crosstalk Calibration. 

Figure 35:  Subsections of Calibration API
Broadcom AFBR-S50-EK-UG102
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2.4.1.1  Range Offset

This parameter gives you the opportunity to compensate application-specific distance offsets. If the ToF sensor is part of a 
system that has another reference edge for assessing the distance, the offset between sensor and this reference edge must 
be defined with the Range Offset parameter.

Formula: Range = RawRange – RangeOffset

Figure 36:  Range Offset

NOTE: Be careful when setting this parameter because range values may turn negative.

 

Broadcom AFBR-S50-EK-UG102
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2.4.1.2  Range Offset Calibration

Unlike the Range Offset parameter, which affects the binned range value, the following pixel offset from table shown in 
Figure 37 intends to do the same for each single pixel range by performing a calibration on a reference plane. The distance 
in meters to the reference plane can be entered in Calibration Target Distance [m] field. After clicking the Run Range 
Offset Calibration Sequence button, the table is filled with the values and distance offsets that are written to the sensor. 
The generated calibration data can also be imported and exported for further processing or analysis. Single offset values 
can also be modified and requested by using the Get and Set buttons.

The main purpose of this calibration procedure is to enable and improve gesture detection applications by minimizing the 
range offset among the single pixels of the 32-pixel array on the receiving side. The effect of this calibration is depicted in 
Figure 38.

Figure 37:  Range Offset Calibration Table

Figure 38:  Effect of a Pixel-to-Pixel Range Offset Calibration
Broadcom AFBR-S50-EK-UG102
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2.4.1.3  Crosstalk Calibration

Crosstalk (Xtalk) calibration is suggested to be carried out for each system design with implemented AFBR-S50 sensors. It 
targets to compensate electrical crosstalk possibly generated by the application PCB, as well as optical crosstalk generated 
by a cover glass mounted above the sensor and therefore affecting its optical path.

Calibration Steps at a Glance

1. Xtalk (shaded) calibration with shaded sensor → electrical Xalk will be compensated.

2. Xtalk (without coverglass) calibration on low reflective target suggested is a black foam as target, for example, 
https://www.dpv-elektronik.de/Packaging-Storage-systems/Packaging/Foams/

The intention is to measure against infinity; however, this is not feasible indoors. Thus a highly, low reflective target is used.

3. Xtalk (with coverglass) calibration with black foam as the target and cover glass in front of the sensor.

Final Crosstalk for each pixel is then calculated by the following formula. 

Example Calibration Sequence for Electrical Xtalk Compensation Only

1. Blind the sensor with a foam while taking measurements, and make sure that the amplitudes are roughly as low as shown 
in the following figure. 

Figure 39:  Blinding Sensor for Xtalk Calibration

2. Click Run Crosstalk Calibration Sequence located in the API tab.

Figure 40:  Crosstalk Calibration Amplitude

The Xtalk vector table is immediately applied to all pixels. For further information, refer to the information in the cover glass 
calibration guide.

Xtalk(total) = Xtalk(shaded) – Xtalk(w/o coverglass) + Xtalk(with coverglass) 
 
 xtalk type     elec cal        electrical + o  
Broadcom AFBR-S50-EK-UG102
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2.4.2  Summary Tab

The Summary tab shows current measurement results as well as generic and DCA information. As the last part of the 
measurement results section, the auxiliary parameters give the user additional information on the internal voltage and 
current levels in units of the ADC, the ASIC temperature and environmental information, such as a Background light indicator 
(in arbitrary units), and the connected shot noise amplitude.

Figure 41:  Summary Tab
Broadcom AFBR-S50-EK-UG102
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2.4.3  Options Tab

All of the available tab settings were already explained except for the API Advanced Options. These options give advanced 
users the possibility to further modify the PBA or DCA settings, which can be unlocked by selecting the Advanced Mode 
check box as shown in the figure below.

Figure 42:  Advanced Mode – API Options

When selected, the user can access more parameters that have appeared in the API tab, which enable a refinement of PBA 
and DCA settings. Tooltips provide more information about each parameter.

Figure 43:  API Advanced Options Exemplarily Shown for the Configuration API Section
Broadcom AFBR-S50-EK-UG102
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Appendix A: Troubleshooting and FAQs

A.1  Related Documents
 AFBR-S50xxxxx Data Sheet

 AFBR-S50 Software Release Notes

A.2  Different Versions of Explorer and Controller Board
If an error message indicates that the software versions of the AFBR-S50 Explorer and microcontroller device software do 
not match, you may have an older or incompatible FW running on the evaluation board.

Figure 44:  Error Message

When upgrading to v1.x, the USB driver version is updated automatically. When downgrading manually to versions older 
than v1.x, you might need to install the older USB driver as well.

Flash the appropriate device software version onto the NXP microcontroller board by following the procedures in Updating 
the Device Software.

Figure 45:  Flashing the Device Software
Broadcom AFBR-S50-EK-UG102
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A.3  SCI Error – No Communication to Sensor

Figure 46:  SCI Error

In principle, this message can have multiple reasons. Most likely, the USB cable was plugged into the openSDA (see 
Figure 7) instead of the KL46Z USB port. Another reason can be that the device software is corrupted and must be flashed 
again (see Section A.2, Different Versions of Explorer and Controller Board). Because this error indicates a serial 
communication issue, it is also possible that your sensor is defective or the USB cable might need to be replaced.

A.4  Xtalk Calibration – 3D Plot Is Not Visible

Figure 47:  Xtalk Calibration

If there is an empty amplitude chart, it might be that the check box for Hide binned pixels in plots is still enabled. To see 
low amplitudes while performing the Xtalk calibration make sure this option is not selected.

A.5  Xtalk Calibration – Amplitude Error

Figure 48:  Amplitude Error Message
Broadcom AFBR-S50-EK-UG102
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This error appears when the amplitude exceeds the default maximum amplitude of 20 LSB while running the Xtalk 
calibration. For Step 2 and Step 3 of the Xtalk calibration (necessary to compensate cover glasses), it might be necessary 
to increase this limit. This can be done in the Calibration Sequence Setup section at the bottom of API tab. 

Figure 49:  Calibration Sequence Setup Section

If it is not visible, you might need to enable the Advanced Mode in the Options tab.
Broadcom AFBR-S50-EK-UG102
31



Broadcom AFBR-S50-EK-UG102
32

AFBR-S50 User Guide Evaluation Kit Quick Start Guide

Revision History 

AFBR-S50-EK-UG102; November 30, 2020
 Updated for new release.

AFBR-S50-EK-UG101; May 6, 2020
 Updated for new release.

AFBR-S50-EK-UG100; December 6, 2019
 Initial release.




	Evaluation Kit Quick Start Guide
	Table of Contents
	Chapter 1: Getting Started
	1.1 Evaluation Kit Overview
	1.2 Hardware and Software Setup
	1.3 Updating the Device Software
	1.4 Performing a Distance Measurement

	Chapter 2: AFBR-S50 Explorer
	2.1 AFBR-S50 Explorer Overview
	2.2 Exploring the Menu Bar
	2.3 Data Visualization Views
	2.3.1 1D Plot View
	2.3.2 3D Plot View
	2.3.3 Raw Data View

	2.4 Tool Panel Overview
	2.4.1 API Tab
	2.4.1.1 Range Offset
	2.4.1.2 Range Offset Calibration
	2.4.1.3 Crosstalk Calibration

	2.4.2 Summary Tab
	2.4.3 Options Tab


	Appendix A: Troubleshooting and FAQs
	A.1 Related Documents
	A.2 Different Versions of Explorer and Controller Board
	A.3 SCI Error – No Communication to Sensor
	A.4 Xtalk Calibration – 3D Plot Is Not Visible
	A.5 Xtalk Calibration – Amplitude Error

	Revision History
	AFBR-S50-EK-UG102; November 30, 2020
	AFBR-S50-EK-UG101; May 6, 2020
	AFBR-S50-EK-UG100; December 6, 2019


